
© 2012 Pro-Ware, LLC

PFS MultiClient





3Contents

3

© 2012 Pro-Ware, LLC

Table of Contents

Foreword 0

Part I Introduction 8

................................................................................................................................... 81 What is PFS MultiClient?

................................................................................................................................... 82 Installing PFS MultiClient

................................................................................................................................... 83 Starting PFS MultiClient for the First Time

................................................................................................................................... 84 Password Encryption

................................................................................................................................... 85 Technical Support

Part II File Manager 12

................................................................................................................................... 121 Opening a File

................................................................................................................................... 122 Adding Files

................................................................................................................................... 133 Removing Files

................................................................................................................................... 134 Managing Folders

................................................................................................................................... 135 Refreshing the File List

................................................................................................................................... 136 Locating Data Files

................................................................................................................................... 137 Save As (Duplicating a File)

................................................................................................................................... 138 Renaming a File

................................................................................................................................... 149 Show File Location

................................................................................................................................... 1410 Emailing a File

................................................................................................................................... 1411 Printing the File List

Part III Applicant Information 16

................................................................................................................................... 161 Overview

................................................................................................................................... 162 Applicant Details

................................................................................................................................... 163 Co-Applicant Details

................................................................................................................................... 174 Employment

................................................................................................................................... 175 Advisors

................................................................................................................................... 186 Prepared For

................................................................................................................................... 187 Notes

................................................................................................................................... 198 Email

Part IV Assets 22

................................................................................................................................... 221 Adding Assets

.......................................................................................................................................................... 22Asset Information 

.......................................................................................................................................................... 23Notes 

.......................................................................................................................................................... 23Related Liabilities 

................................................................................................................................... 232 Deleting Assets



PFS MultiClient4

© 2012 Pro-Ware, LLC

................................................................................................................................... 233 Editing Assets

................................................................................................................................... 234 Duplicating Assets

................................................................................................................................... 235 Deleting All Assets

................................................................................................................................... 236 Sorting Assets

................................................................................................................................... 247 Printing Assets

Part V Liabilities 26

................................................................................................................................... 261 Adding Liabilities

.......................................................................................................................................................... 26General Information 

.......................................................................................................................................................... 26Notes 

.......................................................................................................................................................... 26Related Assets 

................................................................................................................................... 272 Deleting Liabilities

................................................................................................................................... 273 Editing Liabilities

................................................................................................................................... 274 Duplicating Liabilities

................................................................................................................................... 275 Deleting All Liabilities

................................................................................................................................... 276 Sorting Liabilities

................................................................................................................................... 277 Printing Liabilities

Part VI Revenues 30

................................................................................................................................... 301 Adding Revenues

.......................................................................................................................................................... 30General Information 

.......................................................................................................................................................... 31Notes 

................................................................................................................................... 312 Deleting Revenues

................................................................................................................................... 313 Editing Revenues

................................................................................................................................... 314 Duplicating Revenues

................................................................................................................................... 315 Deleting All Revenues

................................................................................................................................... 316 Sorting Revenues

................................................................................................................................... 317 Printing Revenues

Part VII Expenses 34

................................................................................................................................... 341 Adding Expenses

.......................................................................................................................................................... 34General Information 

.......................................................................................................................................................... 34Notes 

................................................................................................................................... 352 Deleting Expenses

................................................................................................................................... 353 Editing Expenses

................................................................................................................................... 354 Duplicating Expenses

................................................................................................................................... 355 Deleting All Expenses

................................................................................................................................... 356 Sorting Expenses

................................................................................................................................... 357 Printing Expenses

Part VIII Reports 38

................................................................................................................................... 381 Financial Statements

.......................................................................................................................................................... 39Changing the Accountant's Report 



5Contents

5

© 2012 Pro-Ware, LLC

................................................................................................................................... 402 Asset Listing

................................................................................................................................... 403 Liability Listing

................................................................................................................................... 404 Revenue Listing

................................................................................................................................... 415 Expense Listing

................................................................................................................................... 416 Applicant Information

Part IX PFS MultiClient Options/Preferences 44

................................................................................................................................... 441 Options

Part X Help Menu 46

................................................................................................................................... 461 PFS MultiClient Help

................................................................................................................................... 462 Feedback...

................................................................................................................................... 463 Activation...

................................................................................................................................... 464 Registration...

................................................................................................................................... 465 Check for Updates

................................................................................................................................... 476 About PFS MultiClient

Part XI PFS MultiClient Tutorial 50

................................................................................................................................... 501 Creating a New Applicant

................................................................................................................................... 502 Adding Sample Assets

................................................................................................................................... 523 Adding Sample Liabilities

................................................................................................................................... 534 Adding Sample Revenues

................................................................................................................................... 535 Adding Sample Expenses

................................................................................................................................... 546 Entering Notes

................................................................................................................................... 547 Printing Financial Statements

Index 57





Top Level Intro
This page is printed before a new

top-level chapter starts

Part

I



PFS MultiClient8

© 2012 Pro-Ware, LLC

1 Introduction

Welcome to PFS MultiClient, the easiest and most flexible software program available for creating
personal financial statements. PFS MultiClient is created, maintained, and supported by Pro-Ware, LLC.

1.1 What is PFS MultiClient?

PFS (or, Personal Financial Statements) Pro is a complete solution which will aid financial professionals
in preparing personal financial statements for their clients. Just create the client, enter their financial
data in the pre-defined categories and PFS MultiClient will create professional financial statements that
can be printed, emailed, or saved to disk and submitted to a bank or other financial institution. Once you
enter the client's data in PFS MultiClient, your work is done. Updating the data is a snap, so you can
modify any of the client's personal financial data when their financial position changes. If your client
already has PFS Plus, the client can update his own personal financial data and transfer the files
directly to you so that you can review the data and incorporate it into your own professional statements
for the client.

1.2 Installing PFS MultiClient

If you are installing PFS MultiClient for the first time or on a different computer, simply follow the on-
screen instructions in the Setup Wizard that appear when you double-click on the Setup file. Should you
need to download the installation for PFS MultiClient, got to the Pro-Ware website:  http:\\www.proware-
cpa.com and click the downloads option on the menu to download the latest demo version of PFS
MultiClient. Entering your Activation data will convert the demo version of PFS MultiClient to an
unrestricted version of the program.

1.3 Starting PFS MultiClient for the First Time

If you have just installed PFS MultiClient for the first time, the Setup Wizard will prompt you to start the
program automatically after the installation is complete. You can leave the box checked to automatically
start PFS MultiClient, or start it by clicking the icon that appears on your desktop after the installation is
complete. PFS MultiClient uses toolbar icons to access the many features of the program. The items on
the toolbar are also available in the File menu.

1.4 Password Encryption

Since you will be entering confidential client data in PFS MultiClient, it is recommended that you create
a password to password-protect and encrypt your personal data. To enable password protection, click
that option located in the File menu. Once you select this option, you will be required to enter your
password twice for confirmation. Take care to create a password that you will remember because you
will not be able to retrieve the data you have entered in PFS MultiClient should you forget your password.

1.5 Technical Support

Technical support is included free with your purchase of PFS MultiClient. Should you need assistance,
you can contact Pro-Ware, LLC using any of the following methods:

 
Voice (402) 861-8800 - Support hours are 8:30 am - 5:00 pm, CST

Fax (402) 861-8653 - 24 hours a day

Internet Web Site - www.proware-cpa.com or www.assetkeeper.com
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Email Address - support@proware-cpa.com

 
When calling for technical support, please have your serial number and the version of PFS MultiClient
that you are using. Your serial number and version number can be found by selecting the About PFS
MultiClient option located under the Help menu.
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2 File Manager

The File Manager provides an easy way for you to select and sort data files. You can add and remove
files from the listing, add and remove entire folders to the listing, create new client files, and delete
existing client files from disk. In addition, you can duplicate a client file by using the "Save As" feature,
rename client files, email a backed-up client file, and even print a entire listing of your client files. This is
the place where all file maintenance is done so becoming familiar with the various options in the File
Manager will immediately make you more productive.

The following items can be found in the File Manager:

Open - Open a file in the list or browse to a specific location to select a file to open.

Add - Create a new file or select an existing file to add to the listing.

Remove - Remove or delete files from the listing.

Folders - Select various data folders to add client files to the listing.

Refresh - Refresh the File Listing based on the data folders selected.

Locate - Locate data files to be added to the file listing.

Save As - Duplicate the selected data file and save it witgh a different name.

Rename - Change the name of an existing data file.

Show - Show the specific location of a data file in Windows Explorer or a Finder window.

Email - Archive the selected file to be attached in an email.

Print - Print a file listing report for all files listed in the File Manager.

2.1 Opening a File

There are two ways to open a file in PFS MultiClient. The first is to highlight the in the list and then click
the Open button and select the "Open Selected File" option (double-clicking the file in the list
accomplishes the same task).

If the file is not currently in your file list, you can select the second option which allows you to browse for
the file you want to open. Once it is located, highlight the file in the dialog box and click "Open" to select
the file.

2.2 Adding Files

To create and add a file to the file listing, click the "Add" button and then select the option to "Add a
New File...". This option will create a new client file and add it automatically to the file list.

To add an existing file to the list, choose that option by clicking on the "Add" button and selecting it from
the list. A dialog box will appear that lets you navigate to any location and select a file to be added to
the list.
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2.3 Removing Files

To remove a file from the list, simply highlight the file to be removed and click the "Remove" icon and
select the "Remove Selected File" option.

To delete a file from disk, highlight the file in the list and select that option by clicking the "Remove"
button.

To remove missing data files from the list, select that option when clicking the "Remove" button. This
option only removes files that have been deleted or moved to another location. It does not delete the files
from disk however, only removes them from the list.

To clear the entire listing, select the "Remove All Files From List" option. Files can always be added
back by clicking the "Refresh" or "Add" options.

2.4 Managing Folders

This option allows you to add a single or multiple data file locations to your file list. By default, your
default data folder will be shown at the top of this list and is added automatically. You can add other
locations as default data folders as well and the file listing will automatically update based on any folders
you select here. You can also remove folders from this list if you no longer need the data files in your file
list.

To add a folder, click the "+" button in the lower-left of the screen, navigate to the desired folder and click
"Select" to add the folder to the list.

To remove a folder, highlight it in the list and click the "-" button in the lower-left of the screen. Answer
"Yes" to remove it from the list.

2.5 Refreshing the File List

This button will update the file list with the most recent data found for the data files already in the list and
add any files found in the list of folders that aren't already in the list.

2.6 Locating Data Files

To locate folders where PFS MultiClient data files exist, click the "Locate" button. By default, your
default data location will be searched. If you would like to search a different location, click the "Change"
button and navigate to the folder or drive that you would like to search for data files. If data files are
found, you can click the "View List of Files" button in the lower-right of the screen to show the files
found.

2.7 Save As (Duplicating a File)

To duplicate a data file (or save it with a different name) highlight the file in the list and click the "Save
As" button. A dialog box will appear which will allow you to save the file under a different name. Once
you type in the name of your new file, PFS MultiClient will create an exact copy of the file with the new
name you choose.

2.8 Renaming a File

To rename a file, highlight the file in the list by clicking once on it and then click the "Rename" button. A
dialog box appears which allows you to enter the new name of the file.
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2.9 Show File Location

This option allows you to highlight a file in the list and open the folder where the file resides.

If you are using a Microsoft Windows operating system, the folder will be opened using Windows
Explorer.

If you are Mac OS, the folder location is shown in a Finder window.

2.10 Emailing a File

To attach and email a PFS file, highlight the file in the list and click the "Email" button. If you have not
yet entered your email settings, you will be prompted to enter them first. For more information on
entering email settings, see the section entitled "Email Settings" under PFS MultiClient Options/
Preferences.

After you have entered your email settings or if you have entered them previously, a dialog box appears
that asks you if you want to password-protect the attached file. Here you are given three password
choices:

1. Set the password to the client's social security number - PFS MultiClient will ask you to confirm
the password.

2. Set a different password - PFS MultiClient asks you to enter the new password and confirm
before proceeding.

3. Send the file as is without any password protection (not recommended)

Once you have made the password selection, PFS MultiClient displays an email screen where you can
select the email server (if you have multiple mail servers set up in PFS MultiClient), edit the To/From and
subject fields, and type a message to accompany the PFS data file you are sending.

2.11 Printing the File List

To print a listing of your data files, click the "Print" button.

You can choose to sort the files based on either the path or the applicant name by clicking on the sort
drop-down menu.

You can print the report directly to your printer by clicking the "Print..." button or preview the report on-
screen by clicking "Preview".

You can also choose the name and location of the .PDF file that is created or append the report to an
existing file by clicking the "PDF" drop-down menu and choosing that respective option.



Top Level Intro
This page is printed before a new

top-level chapter starts

Part

III



PFS MultiClient16

© 2012 Pro-Ware, LLC

3 Applicant Information

This is the starting point for data entry in PFS MultiClient. From this screen, you can enter your name,
address, email address, phone, and other contact information. If you have a co-applicant, you can click
the tab for Co-Applicant data to enter contact information for the co-applicant. In addition, you can enter
Employment History, Financial Advisor Information, and details for the Entity that will receive the
financial statements. Any of the applicant information can be entered or modified at a later time, if
necessary.

3.1 Overview

Once you have entered your Applicant Information, it will be displayed on the Overview tab.

3.2 Applicant Details

Select this tab to enter any of the following information:

Name

Date of Birth

Social Security or Tax ID Number

License or Other Identification Number

Address, City State and Zip Code

Email Address

Daytime, Evening, and Mobile Phone Numbers

Fax Number

Tax Rate

Once finished, your data will be automatically saved.

Note that if you have your effective tax rate entered on this screen, PFS MultiClient will automatically
calculate the tax liability on any unrecognized gains that are designated with any assets.

3.3 Co-Applicant Details

Select this tab to enter any of the following information for you co-applicant:

Name

Date of Birth

Social Security or Tax ID Number

License or Other Identification Number

Address, City State and Zip Code (Click the checkbox to use the same information for the

address that you entered for the applicant)

Email Address

Daytime, Evening, and Mobile Phone Numbers
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Fax Number

Once finished, your data will be automatically saved.

3.4 Employment

This tab allows you to enter employment information. To add an employer, click the "+" button in the
lower left of the window.

Enter any of the following employment information:

Employee (Specifies whether this employment information pertains to the applicant or the

co-applicant)

Start and End Dates of Employment

Position

Employer Name

Contact Name

Address, City, State, Zip Code

Phone and Fax

Email Address

Employer's Website

Click "Save" to save the information when finished.

To delete an entry made to your employment data, highlight the entry and click the "-" (minus) button in
the lower left.

To edit an entry, highlight the entry, click the gear in the lower left of the window and select Edit... from
the drop-down list.

There is also a "Duplicate" option on the drop-down list that will duplicate the previous employer
information entered. From there, you can modify the data as needed for the employment information.

3.5 Advisors

This tab allows you to enter financial advisor information. To add an advisor, click the "+" button in the
lower left of the window.

Enter any of the following information:

Advisor Of (Specifies whether this advisor information pertains to the applicant or the co-

applicant)

Advisement Role

Advisor Name
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Company Name

Address, City, State, Zip Code

Phone and Fax

Email Address

Advisor's Website

Click "Save" to save the information when finished.

To delete an entry made for your financial advisors, highlight the entry and click the "-" (minus) button in
the lower left.

To edit an entry, highlight the entry, click the gear in the lower left of the window and select Edit... from
the drop-down list.

There is also a "Duplicate" option on the drop-down list that will duplicate the previous advisor
information entered. From there, you can modify the data as needed for the advisor information.

3.6 Prepared For

This tab allows you to enter information pertaining to the institution that this data is being prepared for.
To add an institution, click the "+" button in the lower left of the window.

Enter any of the following information:

Institution Name

Contact Name

Address, City, State, Zip Code

Phone and Fax

Email Address

Institution's Website

Click "Save" to save the information when finished.

To delete an entry made to your "Prepared For" data, highlight the entry and click the "-" (minus) button
in the lower left.

To edit an entry, highlight the entry, click the gear in the lower left of the window and select Edit... from
the drop-down list.

There is also a "Duplicate" option on the drop-down list that will duplicate the previous information
entered. From there, you can modify the data as needed.

3.7 Notes

There are three different types of notes that can be entered in PFS MultiClient:

1. Type Notes - These notes pertain to the class, or type, of asset, liability, revenue or expense.
The "Type Notes" can be printed on the financial statements and normally will precede the
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specific "Report Notes" which can be entered for each individual asset, liability, revenue, or
expense that is entered for the client.

2. Report Notes - Report notes can be entered for any asset, liability, revenue, or expense entered
for the client. These can, in turn, be printed on the client's financial statement as accountant's
notes. These notes are normally printed after any "Type Notes" that are entered for the type
(class) of asset, liability, revenue, or expense entered.

3. Notes - These notes are internal notes about the asset, liability, revenue, or expense that will not
be printed on the financial statements.

3.8 Email

There are several email options  in PFS MultiClient. When clicking on the Email drop-down menu, you
can elect to send a message or attach the selected applicant's data file to an email message. In
addition, you can choose from among several recipients when clicking the "Email" option depending on
how many email addresses have been entered for the applicant.
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4 Assets

Click Assets on the toolbar or from the File menu to enter asset information for you and your co-
applicant. When you click the Assets button for the first time, you will see a blank window where you
can add any assets. To start, click the "+" at the bottom-left of the window.

The following types of assets can be entered in PFS MultiClient:

Cash

Receivables

Marketable Securities

Partnership Interests

Value of Life Insurance Policies

Retirement Accounts

Vehicles

Personal Property

Primary Residence

Real Property

Other Assets

Every type of asset listed above can have an associated note which can be printed on the personal
financial statement. Each asset can also have its own specific Note as well as a Report Note that will
print as an accountant's note on the financials.

4.1 Adding Assets

To add an asset, click the "+" sign in the lower-left of the window.

4.1.1 Asset Information

First, select the Asset Type that you are entering data for. Select from among the following asset types:

Cash

Receivables

Marketable Securities

Partnership Interests

Cash Value of Life Insurance Policies

Retirement Accounts

Vehicles

Personal Property

Primary Residence

Other Real Property
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Other Assets

After selecting the asset type, enter the description, cost, valuation method, fair market value, and
valuation date.

If the value of the asset is greater than its cost, there is unrecognized gain that will occur if the asset is
liquidated. PFS MultiClient will automatically calculate the tax on the unrecognized gain based on the
tax rate information that is entered in the Applicant Information screen.

4.1.2 Notes

Enter any additional notes for your asset here.

4.1.3 Related Liabilities

You can link any related liabilities for the asset on this screen. To link the asset, click the "+" sign on
the lower-left of the window. A popup list of Liabilities will appear from which you can choose to link the
asset to.

4.2 Deleting Assets

To delete an asset that was entered previously, click the minus button in the lower left of the window. A
confirmation screen will appear that indicates that you cannot recover the asset once it is deleted. Click
"Delete" to permanently remove the asset from your file.

4.3 Editing Assets

To edit an asset, click the gear at the bottom left of the window and click "Edit..." The Asset Details
screen appears where you can change any of the existing information previously entered for the asset.
Click "Save" to save your changes or "Cancel" to quit without saving. 

4.4 Duplicating Assets

From the Asset Listing screen, you can highlight any asset and duplicate the information if you have
similar assets. With the asset highlighted on the screen, click the gear on the lower-left of the window
and then click "Duplicate". This will create a new asset with the same information as the highlighted
asset that was previously entered. You will see a duplicated asset with an additional auto-incremented
number listed on the screen. From there you can change any of the information by double-clicking the
asset, editing any of the fields and then clicking "Save" to save your changes. Click "Cancel" to close
the screen without applying the changes.

4.5 Deleting All Assets

Choose this option by clicking the gear at the lower-left of the window and selecting the "Delete All
Assets" option. Be careful in using this option because it will delete all of the assets in the file. A
confirmation screen will appear asking you if this is really what you want to do. Click "Delete All" to
confirm the deletion or "Cancel" to cancel the deletion.

4.6 Sorting Assets

The default sorting option for the assets in your file is to sort by liquidity. Assets that are more liquid,
such as cash and marketable securities will appear before assets such as real property or cash value of
life insurance policies. You can customize the sorting within each asset type by selecting that option
from the gear menu. When you select this option, a "Customize List Order" screen appears where you
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can move assets up or down according to how you want them sorted. Use the arrows at the bottom left
of the window to move assets up or down depending on your preference. Click the "Close" button to
return to the Asset Listing screen.

4.7 Printing Assets

You can elect to print just one asset by highlighting the asset on the Asset Listing screen and then
selecting the option "Print Selected Asset..." from the gear menu in the lower left of the screen. You can
also print all of the assets by selecting the "Print Asset Listing..." option. When you select the printing
options, a screen will appear that will let you customize your report. You can change the sorting, which
assets to include, the format of the report, the layout, and many other aspects of the report that will be
printed. Click the "Preview" button to preview the report on-screen or "Print" to print the report without
previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.
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5 Liabilities

Click Liabilities on the toolbar or from the File menu to enter liability information for you and your co-
applicant. When you click the Liabilities button for the first time, you will see a blank window where you
can add any liabilities. To start, click the "+" at the bottom-left of the window.

The following types of liabilities can be entered in PFS MultiClient:

Notes/Loans Payable

Income Taxes

Mortgages Payable

Contingent Liabilities

Other Liabilities

5.1 Adding Liabilities

To add a liability, click the "+" sign in the lower-left of the window.

5.1.1 General Information

First, select the Liability Type that you are entering data for. Select from among the following liability
types:

Notes/Loans Payable

Income Taxes

Mortgages Payable

Contingent Liabilities

Other Liabilities

After selecting the liability type, enter the description, amount, payoff amount, interest rate, remaining
payments, and monthly or annual payment.

In addition, if check the box to auto-add the expense, an expense will be created for the liability.

5.1.2 Notes

Enter any additional notes for your liability here.

5.1.3 Related Assets

You can link any related assets for the liability on this screen. To link the liability, click the "+" sign on
the lower-left of the window. A popup list of Assets will appear from which you can choose to link the
liability to.
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5.2 Deleting Liabilities

To delete a liability that was entered previously, click the minus button in the lower left of the window. A
confirmation screen will appear that indicates that you cannot recover the liability once it is deleted.
Click "Delete" to permanently remove the liability from your file.

5.3 Editing Liabilities

To edit a liability, click the gear at the bottom left of the window and click "Edit..." The Liability Details
screen appears where you can change any of the existing information previously entered for the liability.
Click "Save" to save your changes or "Cancel" to quit without saving. 

5.4 Duplicating Liabilities

From the Liability Listing screen, you can highlight any liability and duplicate the information if you have
similar liabilities. With the liability highlighted on the screen, click the gear on the lower-left of the
window and then click "Duplicate". This will create a new liability with the same information as the
highlighted liability that was previously entered. You will see a duplicated liability with an additional auto-
incremented number listed on the screen. From there you can change any of the information by double-
clicking the liability, editing any of the fields and then clicking "Save" to save your changes. Click
"Cancel" to close the screen without applying the changes.

5.5 Deleting All Liabilities

Choose this option by clicking the gear at the lower-left of the window and selecting the "Delete All
Liabilities" option. Be careful in using this option because it will delete all of the liabilities in the file. A
confirmation screen will appear asking you if this is really what you want to do. Click "Delete All" to
confirm the deletion or "Cancel" to cancel the deletion.

5.6 Sorting Liabilities

The default sorting option for the liabilities in your file is to sort by liquidity. Liabilities that are more
liquid, such as loans payable will appear before liabilities such as a contingent liability. You can
customize the sorting within each liability type by selecting that option from the gear menu. When you
select this option, a "Customize List Order" screen appears where you can move liabilities up or down
according to how you want them sorted. Use the arrows at the bottom left of the window to move
liabilities up or down depending on your preference. Click the "Close" button to return to the Liability
Listing screen.

5.7 Printing Liabilities

You can elect to print just one liability by highlighting the liability on the Liability Listing screen and then
selecting the option "Print Selected Liability..." from the gear menu in the lower left of the screen. You
can also print all of the liabilities by selecting the "Print Liability Listing..." option. When you select the
printing options, a screen will appear that will let you customize your report. You can change the sorting,
which liabilities to include, the format of the report, the layout, and many other aspects of the report that
will be printed. Click the "Preview" button to preview the report on-screen or "Print" to print the report
without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.
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6 Revenues

Click Revenues on the toolbar or from the File menu to enter revenue information for you and your co-
applicant. When you click the Revenues button for the first time, you will see a blank window where you
can add any revenues. To start, click the "+" at the bottom-left of the window.

The following types of revenues can be entered in PFS MultiClient:

Salaries/Wages

Bonuses/Commissions

Dividends

Interest Income

Rental Income

Royalties

Child Support Received

Alimony Received

Retirement Benefits

Partnership Distributions

Other Income

6.1 Adding Revenues

To add a revenue or income item, click the "+" sign in the lower-left of the window.

6.1.1 General Information

First, select the Revenue Type that you are entering data for. Select from among the following revenue
types:

Salaries/Wages

Bonuses/Commissions

Dividends

Interest Income

Rental Income

Royalties

Child Support Received

Alimony Received

Retirement Benefits

Partnership Distributions

Other Income
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After selecting the revenue type, enter the description, amount, and frequency of the revenue stream.

6.1.2 Notes

Enter any additional notes for the revenue here.

6.2 Deleting Revenues

To delete a revenue amount that was entered previously, click the minus button in the lower left of the
window. A confirmation screen will appear that indicates that you cannot recover the revenue item once
it is deleted. Click "Delete" to permanently remove the revenue amount from your file.

6.3 Editing Revenues

To edit a revenue amount, click the gear at the bottom left of the window and click "Edit..." The Revenue
Details screen appears where you can change any of the existing information previously entered for the
revenue item. Click "Save" to save your changes or "Cancel" to quit without saving. 

6.4 Duplicating Revenues

From the Revenue Listing screen, you can highlight any revenue item and duplicate the information if you
have similar revenue streams. With the revenue item highlighted on the screen, click the gear on the
lower-left of the window and then click "Duplicate". This will create a new revenue amount with the same
information as the highlighted revenue item that was previously entered. You will see a duplicated
revenue amount with an additional auto-incremented number listed on the screen. From there you can
change any of the information by double-clicking the revenue item, editing any of the fields and then
clicking "Save" to save your changes. Click "Cancel" to close the screen without applying the changes.

6.5 Deleting All Revenues

Choose this option by clicking the gear at the lower-left of the window and selecting the "Delete All
Revenues" option. Be careful in using this option because it will delete all of the revenue amounts in the
file. A confirmation screen will appear asking you if this is really what you want to do. Click "Delete All"
to confirm the deletion or "Cancel" to cancel the deletion.

6.6 Sorting Revenues

The default sorting option for the revenues in your file is shown on the drop-down list. The default sorting
for revenues in PFS MultiClient can be changed if you like. You can customize the sorting by selecting
that option from the gear menu. When you select this option, a "Customize List Order" screen appears
where you can move revenue items up or down according to how you want them sorted. Use the arrows
at the bottom left of the window to move revenue amounts up or down depending on your preference.
Click the "Close" button to return to the Revenue Listing screen.

6.7 Printing Revenues

You can elect to print just one revenue item by highlighting it on the Revenue Listing screen and then
selecting the option "Print Selected Revenue..." from the gear menu in the lower left of the screen. You
can also print all of the revenue items by selecting the "Print Revenue Listing..." option. When you
select the printing options, a screen will appear that will let you customize your report. You can change
the sorting, which revenue amounts to include, the format of the report, the layout, and many other
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aspects of the report that will be printed. Click the "Preview" button to preview the report on-screen or
"Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.
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7 Expenses

Click Expenses on the toolbar or from the File menu to enter expense information for you and your co-
applicant. When you click the Expenses button for the first time, you will see a blank window where you
can add any expenses. To start, click the "+" at the bottom-left of the window.

The following types of expenses can be entered in PFS MultiClient:

Installment Payments

Mortgage Payments

Rental Payments

Child Support Payments

Alimony Payments

Insurance Payments

Household Expenses

Medical/Dental Expenses

Other Expenses

7.1 Adding Expenses

To add an expense, click the "+" sign in the lower-left of the window.

7.1.1 General Information

First, select the Expense Type that you are entering data for. Select from among the following expense
types:

Installment Payments

Mortgage Payments

Rental Payments

Child Support Payments

Alimony Payments

Insurance Payments

Household Expenses

Medical/Dental Expenses

Other Expenses

After selecting the expense type, enter the description and amount of the expense.

7.1.2 Notes

Enter any additional notes for the expense item here.
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7.2 Deleting Expenses

To delete an expense amount that was entered previously, click the minus button in the lower left of the
window. A confirmation screen will appear that indicates that you cannot recover the expense item once
it is deleted. Click "Delete" to permanently remove the expense amount from your file.

7.3 Editing Expenses

To edit an expense amount, click the gear at the bottom left of the window and click "Edit..." The
Expense Details screen appears where you can change any of the existing information previously
entered for the expense item. Click "Save" to save your changes or "Cancel" to quit without saving. 

7.4 Duplicating Expenses

From the Expense Listing screen, you can highlight any expense item and duplicate the information if
you have similar expenses. With the expense item highlighted on the screen, click the gear on the
lower-left of the window and then click "Duplicate". This will create a new expense amount with the same
information as the highlighted expense item that was previously entered. You will see a duplicated
expense amount with an additional auto-incremented number listed on the screen. From there you can
change any of the information by double-clicking the expense item, editing any of the fields and then
clicking "Save" to save your changes. Click "Cancel" to close the screen without applying the changes.

7.5 Deleting All Expenses

Choose this option by clicking the gear at the lower-left of the window and selecting the "Delete All
Expenses" option. Be careful in using this option because it will delete all of the expense amounts in the
file. A confirmation screen will appear asking you if this is really what you want to do. Click "Delete All"
to confirm the deletion or "Cancel" to cancel the deletion.

7.6 Sorting Expenses

The default sorting option for the expenses in your file is shown on the drop-down list. The default sorting
for expenses in PFS MultiClient can be changed if you like. You can customize the sorting by selecting
that option from the gear menu. When you select this option, a "Customize List Order" screen appears
where you can move expense items up or down according to how you want them sorted. Use the arrows
at the bottom left of the window to move expense amounts up or down depending on your preference.
Click the "Close" button to return to the Expense Listing screen.

7.7 Printing Expenses

You can elect to print just one expense item by highlighting it on the Expense Listing screen and then
selecting the option "Print Selected Expense..." from the gear menu in the lower left of the screen. You
can also print all of the expense items by selecting the "Print Expense Listing..." option. When you
select the printing options, a screen will appear that will let you customize your report. You can change
the sorting, which expense amounts to include, the format of the report, the layout, and many other
aspects of the report that will be printed. Click the "Preview" button to preview the report on-screen or
"Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.
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8 Reports

This option located in the toolbar and on the File menu will display a list of the reports you can print in
PFS MultiClient. The following reports are available in PFS MultiClient:

Financial Statements

Asset Listing

Liability Listing

Revenue Listing

Expense Listing

Applicant Information

8.1 Financial Statements

You can print complete personal financial statements for any applicant by selecting the "Financial
Statement" option from the Reports button on the toolbar. When you select the "Financial Statements"
option, a screen appears that allows you to customize many of the components of financial statements
that will be printed. You can change the following items for the applicant's printed financial statement:

Applicant Name - You can change or edit the name of the applicant, if necessary. In
addition, you can select from among several different display options for the applicant/co-
applicant by simply dropping down the menu next to the applicant's name.

Document Title - Change the title for this statement, if necessary.

Prepared For - You can select the "Prepared For" item among the list provided or add a
new item by clicking the "+" sign next to the drop-down list.

Pages to Print - Select the following pages that will compose the financial statement for the

applicant:

Cover Page - A cover page may be printed containing the applicant's name and date

reflected on the statement.

Contents Page - A table of contents is automatically generated for the financial

statements.

Accountant's Report - Elect to include the Accountant's Report for the financial
statement. The included report can be used as a template and customized for the
applicant. Customized reports can be created based on the template and saved so that
they are available in the drop-down menu.

Statement of Financial Condition - Choose whether to include this statement for the

applicant.

Statement of Revenues and Expenses - Choose whether to include this statement for the

applicant.

Notes - Choose to include any "Notes" for this applicant.

Supporting Schedules - You can elect to include any supporting schedules for the
applicant. In addition, you can print a separator page before the schedule.
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Signature Lines - You can have a signature line printed on the cover page and/or the
statement pages. The signature lines can have 1 or 2 lines, if needed for both the applicant
and co-applicant.

Header/Footer - You can include Headers and Footers for the report. Select the page
numbering for the statements the date to  be printed and the various date formats to be
included in either the header or the footer.

You can also choose to restore the default settings for the financial statements by clicking the "Restore
Defaults" button.

Once you have selected the settings for your report, you can click the "Preview" button to preview the
report on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.

8.1.1 Changing the Accountant's Report

Included in PFS MultiClient is a standard accountant's report that can be used as is or edited and
changed to fit your firm's or applicant's needs. To edit the existing report or create a new one, click the
"Edit" icon next to the Accountant's Report drop-down menu. The Standard Compilation Report appears
on the left side of the screen as well as any other reports you have created and saved. The included
Standard Compilation Report is a template which can be used for any additional reports that you create.
The Standard Compilation Report cannot be changed or modified because it is a template. Instead, a
new report based on the Standard Compilation report can be created which can be customized.

To do this, click the "+" button at the bottom-left of the screen and choose the drop-down option to
create a new report based on selected item... A new accountant's report will be displayed that you can
edit and save. You can change the name of the report, the title of the report, and any of the verbiage
contained in the body of the report. The report is saved in the location set in the program preferences.

In addition to the edit features, you can insert  or remove any of the various "Merge Fields" available in
PFS MultiClient. Merged fields are identified as the text to be merged within 2 less than and greater than
signs on either side of the field. For example:  << APPLICANT NAME >> represents the name of the
applicant.

The following merge fields can be inserted in any location of the document:

Applicant and co-applicant's name, city and state
Document title and institution that the statement is being prepared for
Various dates and formats
Accountant's name, firm name, city and state
Various other insertions based on the applicant's name and accounting firm

To insert a merged field, place your cursor any place in the document and click the "Insert Merged
Fields" drop-down menu and select the merged field to insert. You will see the merged field appear
within the less than and greater than signs in that place of the document. If you need to edit the
replacement values of the merge fields, you can do so from the report listing screen. Click the gear drop-
down menu and select "Edit merge field replacement values..." In this screen you can alter the
replacement values of several of the merged fields that appear on the report and in various other areas of
PFS MultiClient. You can also see exactly where the contents of the merge field originate and the



PFS MultiClient40

© 2012 Pro-Ware, LLC

location where they can be changed within the program.

When you have finished making the desired modifications, click the "Save" button to save the new
accountant's report. The new report will appear in the list on the left. You can select this report or edit it
if you need to make any further changes. Note that the original report template included in PFS
MultiClient cannot be modified. It first has to be saved under a different name. Once it has been saved
and appears on the left side of the screen, you will be able to make changes and save them.

You can also create a blank accountant's report which you can fully customize for your own purposes.
Any reports created will automatically appear on the left side of the screen and will be available whenever
printing the financial statements for the applicant.

8.2 Asset Listing

You can print any or all of the Assets by selecting the "Asset Listing" option from the Reports button on
the toolbar. When you select the "Asset Listing" report, a screen will appear that will let you customize
the report. You can change the sorting, which assets to include, the format of the report, the layout, and
many other aspects of the report that will be printed. Click the "Preview" button to preview the report on-
screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.

8.3 Liability Listing

You can print any or all of the Liabilities by selecting the "Liability Listing" from the Reports button on
the toolbar. When you select the "Liability Listing", a screen will appear that will let you customize your
report. You can change the sorting, which liabilities to include, the format of the report, the layout, and
many other aspects of the report that will be printed. Click the "Preview" button to preview the report on-
screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.

8.4 Revenue Listing

You can print any or all of the Revenue items by selecting the "Revenue Listing" from the Reports button
on the toolbar. When you select the "Revenue Listing" report to print, a screen will appear that will let
you customize your report. You can change the sorting, which revenue amounts to include, the format of
the report, the layout, and many other aspects of the report that will be printed. Click the "Preview"
button to preview the report on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.
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8.5 Expense Listing

You can print any or all of the Expense items by selecting the "Expense Listing" from the Reports
button from the toolbar. When you select the "Expense Listing" report, a screen will appear that will let
you customize your report. You can change the sorting, which expense amounts to include, the format
of the report, the layout, and many other aspects of the report that will be printed. Click the "Preview"
button to preview the report on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.

8.6 Applicant Information

You can print the Applicant and Co-Applicant information by selecting the "Applicant Information" option
from the Reports button on the toolbar. When you select the "Applicant Information" report, a screen will
appear that will let you customize the report. You can change many of the options for the report
including which information to include. In addition, you can change the format of the report, the layout,
and many other aspects of the report that will be printed. Click the "Preview" button to preview the report
on-screen or "Print" to print the report without previewing it.

In addition, you can also choose to save the report to disk as a .pdf file. This can be handy if you are
emailing the report or need to view it on a computer that does not have PFS MultiClient installed. You
can select the name of the file and the location on your computer where you want it saved.
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9 PFS MultiClient Options/Preferences

You can change your preferences for PFS MultiClient by selecting the "Options..." item in Windows
located at the bottom of the "Edit" menu or the "Preferences" item in the PFS MultiClient menu for Mac.

9.1 Options

You can change your preferences for PFS MultiClient by selecting the "Options..." item located at the
bottom of the "Edit" menu.

By selecting the "Options..." you can change the following:

Data Files Options - Choose whether to start the File Manager or the last client's home
screen, change settings for the File Manager and show applicant's name or the file path
when displaying the files in the recent files menu. In addition, folders can also be managed
by selecting the gear drop-down in the lower left of the screen.

Data Entry Options - Change the keyboard behavior during data entry, keyboard
navigation, default payment types and tax calculations.

Email Options - Choose whether to use the built-in mail server or your system default email
program. You can also enter email server settings here. Enter description, SMTP server
address, port, and authentication information, if necessary, including user name and
password. Once finished, you can test your email settings by clicking the button. You can
add multiple email servers in PFS MultiClient. You may have to contact your system
administrator for help for some of the items required to add a mail server.

Report Options - Turn dollar rounding on or off, show the printer dialog, choose the
alignment of reports, font size and pdf viewer to use when previewing reports.

Accountant's Report Options - Change merge field replacement values, report files location,
letterhead margins, or specify a specific pdf file to use for a letterhead.

Password Options - Choose whether to be prompted for a password when creating a new
applicant file. You can also make PFS MultiClient forget any passwords previously saved
by clicking that button on this page.

Update Options - Change the frequency of how often PFS MultiClient checks for updates.

General Options - Choose whether to display PFS MultiClient's splash screen when starting
the program. You can also restore all "Do Not Show Again" messages to unchecked when
displaying any dialog messages.
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10 Help Menu

The Help menu has the following options available:

PFS MultiClient Help

Feedback...

Activation...

Registration...

Check for Updates

About PFS MultiClient

10.1 PFS MultiClient Help

Choosing this option displays the Help for PFS MultiClient. You can choose any of the items located in
the table of contents to browse or print.

10.2 Feedback...

This option will display a screen that you can fill out and submit to Pro-Ware, LLC. You can provide
feedback for enhancements that you would like to see, general questions that you would like to submit
to our technical support staff for review, or problems you may have encountered while using PFS
MultiClient. Clicking "Send" will email the submission form directly to Pro-Ware's support staff.

Note: This option is located under the PFS MultiClient menu if you are running the Mac version.

10.3 Activation...

If you are running the demo version of PFS MultiClient for Windows, you can choose this option once
you purchase the software. You will be able to enter the activation information that was sent to you by
Pro-Ware, LLC. Once complete, the software will stop running in the demo mode and you will be able to
use beyond the 30-day limit.

10.4 Registration...

Choose this option to enter your registration information for submission to Pro-Ware. If any of your
registration information has changed, you can enter the changes here and they will be submitted to our
office so that we can update your registration in our user database. Changes may take up to 72 hours to
be posted to your account.

10.5 Check for Updates

Select this option at any time to check for updates to PFS MultiClient for Windows. This option can be
selected at any time and is entirely independent of the automatic update checking that PFS MultiClient
makes according to your PFS MultiClient Options located under the Edit menu.
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10.6 About PFS MultiClient

This screen will display information about the version and date of the PFS MultiClient release that you
are currently running. In addition, you can display system information by selecting the "System
Information" button.

Note: This option is located under the PFS MultiClient menu if you are running the Mac version.
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11 PFS MultiClient Tutorial

This tutorial will guide you through the process of creating a new applicant, entering applicant financial
data, and preparing and printing financial statements.

11.1 Creating a New Applicant

To create a new applicant file, select New Applicant from the File menu. Type the name of the new file
(in this case we will name the "Tutorial") and click "Save" to create the file.

Once the file is created, click the Applicant Details tab and then click the "Edit" button to enter the
details for the applicant. Click "Save" to save the add the applicant's information.

Click the Co-Applicant Details tab to enter information for the co-applicant (spouse, for example), if
necessary. Note that the address information can be copied from the Applicant Details by checking the
option "Use applicant address". Click "Save" to save the add the co-applicant's information.

Click the Employment tab to add an employer for the applicant and co-applicant if necessary. To add a
place of employment click the "+" button in the lower-left corner. Enter all applicable information and
click "Save" to add the employer information. You can add as many employers and employment history
for either the applicant or co-applicant. Delete any employment entries by clicking the "-" button in the
lower-left of the screen.

Add any advisors (financial institutions, CPA firms, attorneys, etc.) in the "Advisors" tab by clicking the
"+" in the lower-left of the screen. Once finished, click "Save" to save the advisor for the applicant/co-
applicant. Advisors can be removed by clicking the "-" button.

Click the Prepared For tab to enter the name of any potential recipients of this data. Recipients can be
added and removed as described for employers and advisors.

11.2 Adding Sample Assets

To add assets for the Sample Applicant, click the "Assets" toolbar icon and then click "+" to add an
asset. We will add the following assets to the tutorial data file:

Asset #1:
Description:  First National Bank Check ing Account
Asset Type:  Cash
Present Value:  $12,400.00
Valuation Method:  Same as Cost

Click save to save the applicant's checking account information, then click "+" to add the next asset.

Asset #2:
Description:  First Savings Bank Savings Account
Asset Type:  Cash
Present Value:  $21,275.00
Valuation Method:  Same as Cost

Click save to save the applicant's savings account information, then click "+" to add the next asset.
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Asset #3:
Description:  Market Trade Portfolio
Asset Type:  Marketable Securities
Present Value:  $244,500.00
Valuation Method:  Market Comparison

Click save to save the applicant's stock portfolio information, then click "+" to add the next asset.

Asset #4:
Description:  ABC Real Property Partnership
Asset Type:  Partnership Interests
Present Value:  $16,925.00
Valuation Method:  Appraisal
Valuation Date:  04/15/2012
Cost/Basis:  $22,460.00

Click save to save the applicant's partnership information, then click "+" to add the next asset.

Asset #5:
Description:  IRA (Mark  Sample)
Asset Type:  Retirement Accounts
Present Value:  $421,815.00
Valuation Method:  Market Comparison
Valuation Date:  04/15/2012
Cost/Basis:  $361,550.00

Click save to save the applicant's IRA information, then click "+" to add the next asset.

Asset #6:
Description:  2007 Lexus and 2010 Toyota
Asset Type:  Vehicles
Present Value:  $31,500.00
Valuation Method:  Replacement Cost
Valuation Date:  04/15/2012
Cost/Basis:  $52,500.00

Click save to save the applicant's vehicle information, then click "+" to add the next asset.

Asset #7:
Description:  Residence on Williams St.
Asset Type:  Primary Residence
Present Value:  $345,500.00
Valuation Method:  Appraisal
Valuation Date:  04/15/2012
Cost/Basis:  $426,900.00

Click save to save the applicant's primary residence account information.

Close the "Assets" screen to return to the PFS MultiClient home screen.
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11.3 Adding Sample Liabilities

Adding liabilities is very similar to adding assets. To add liabilities for the Sample Applicant, click the
"Liabilities" toolbar icon and then click "+" to add a liability. We will add the following liabilities to the
tutorial data file:

Liability #1:
Description:  Mortgage - Williams St. Residence
Liability Type:  Mortgages Payable
Payoff Amount:  $261,960.00
Original Amount:  $350,000.00
Interest Rate:  5.1%
Remaining Payments:  240
Payment:  $1,450.00 (Monthly - Leave box checked to create related expense)

Click save to save the applicant's mortgage information, then click "+" to add the next liability.

Liability #2:
Description:  Vehicle Loans
Liability Type:  Notes/Loans Payable
Payoff Amount:  $16,500.00
Original Amount:  $44,500.00
Interest Rate:  8.0%
Remaining Payments:  28
Payment:  $712.00 (Monthly - Leave box checked to create related expense)

Click save to save the applicant's vehicle loan information, then click "+" to add the next liability.

Liability #3:
Description:  Business Loan
Liability Type:  Notes/Loans Payable
Payoff Amount:  $61,500.00
Original Amount:  $84,000.00
Interest Rate:  6.8%
Remaining Payments:  37
Payment:  $2,050.00 (Monthly - Leave box checked to create related expense)

Click save to save the applicant's business loan information.

Linking assets and liabilities:

The 3 loans previously entered all have related assets. To link the assets, double-click the mortgage
liability in the liability screen and click the Related Assets tab. Click "+" and a drop-down list appears of
all assets in the file. Choose the "Residence on Williams St." asset to link it to this mortgage loan. Click
"Save" to save this change.

Do the same for both the vehicle loan and the business loan. the vehicle loan is linked to the "2007
Lexus and 2010 Toyota" asset and the business loan is linked to the "ABC Real Property Partnership
asset". Click "Save" for each linked asset/liability.

Close the "Liabilities" to return to the PFS MultiClient home screen.
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11.4 Adding Sample Revenues

To add revenue amounts for the Sample Applicant, click the "Revenues" toolbar icon and then click "+"
to add a revenue amount. We will add the following revenue amounts to the tutorial data file:

Revenue #1:
Description:  M. Sample's Salary
Revenue Type:  Salaries/Wages
Annual Amount:  $224,000.00

Click save to save the applicant's salary information, then click "+" to add the next revenue amount.

Revenue #2:
Description:  T. Sample's Salary
Revenue Type:  Salaries/Wages
Annual Amount:  $71,000.00

Click save to save the co-applicant's salary information, then click "+" to add the next revenue amount.

Revenue #3:
Description:  Dividend Income
Revenue Type:  Dividends
Annual Amount:  $4,500.00

Click save to save the applicant's dividend information, then click "+" to add the next revenue amount.

Revenue #4:
Description:  Distribution from Partnership
Revenue Type:  Partnership Distributions
Annual Amount:  $8,5000.00

Close the Revenues screen to return to the PFS MultiClient home screen.

11.5 Adding Sample Expenses

To add expenses for the Sample Applicant, click the "Expenses" toolbar icon. Before adding new
expenses, note that there already 3 expenses that were set up automatically when we added the
liabilities. To add and expense, click "+" to add the expense. We will add the following additional
expenses to the tutorial data file:

Expense #4:
Description:  Insurance (Home and Auto)
Revenue Type:  Insurance Payments
Annual Amount:  $4,500.00

Click save to save the applicant's insurance expense information, then click "+" to add the next revenue
amount.

Expense #5:
Description:  Household Expenses
Revenue Type:  Household Expenses
Annual Amount:  $140,000.00
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Click save to save the applicant's household expense information.

Close the Revenues screen to return to the PFS MultiClient home screen.

11.6 Entering Notes

PFS MultiClient has 3 different types of notes that can be added:

Internal Notes

Report Notes

Category Notes

Internal notes are to document information about a specific asset, liability, revenue, or expense that you
DO NOT want to appear on the financial statements. 

Report notes are to document information about a specific asset, liability, revenue, or expense that you
DO want to appear on the financial statements. 

Category notes are specific only to an asset, liability, revenue, or expense type (or class) that you DO
want to appear on the financial statements.

To access the Internal Notes and Report Notes, select the Assets, Liabilities, Revenues, or Expenses
and then double-click the item for which you want to add the note.

To illustrate, we select the Assets icon and then double-click the Market Trade Portfolio and then click
the "Notes" tab. Add the following notes to for the asset:

Internal Notes:
Market Trade Account#:  9100-5987-02

Report Notes:
Portfolio valued as of 12/31/2011.

Click "Save" to save the note and then close the Assets screen to return to the home screen.

Next, we will enter Category Notes by clicking on the "Notes" toolbar icon. Locate the Assets -
Marketable Securities and double-click to display the "Type Notes" screen and type the following:

Market comparison used to value stock  portfolio.

Click "Save" and then close the Type Notes window to return to the Home screen.

11.7 Printing Financial Statements

Now that all of the information has been entered for the sample tutorial file, we are ready to print a
personal financial statement.

Click the "Reports" icon and select Financial Statements from the drop-down list. By default, the
following pages will be printed for the financial statements.

Cover page
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Contents page

Accountant's report

Statement of financial condition

Statement of revenues and expenses

Note

Supporting schedules

For the purposes of this tutorial, we will print all of the pages of the report.

The following changes can also be made to customize the financial statements for each applicant.

The applicant/co-applicant name as it is displayed

The document title

The "Prepared For" line

A separator page for the supporting schedules

Signature lines

Page numbering

Date displayed in header/footer

The wording of the Accountant's Report

For the purposes of this tutorial, we will accept the defaults. Click the "Preview" button to display the
Financial Statement on the screen.
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